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 How to Find Information in Help
The Epson Stylus Series Help Window works just like the Help windows you find in other applications. If 
you are not familiar with how Help operates, here are a few tips to get you started.

 Using the Help Buttons
There are seven buttons near the top of the Help Window. You can "press" a button by clicking on it with 
your mouse.

To return to the main Help contents:

Click 

To search for information about a particular topic:

    For Windows 3.1x users:

1 Click .    The following screen appears:

2 Type or select a key word and then click 

3 Select a topic from the list and then click 
    For Windows 95 users:

1 Click .    The following screen appears:



2 Type or select a key word.
3 Click the index and then click .

4 Select a topic from the list and then click .

To go back to the screen that you viewed previously:

Click 

To jump back to a topic that you viewed previously:

1 Click 

2 Select the topic that you want to review from the history list.

To display a glossary of terms:

1 Click .    The following screen appears:



2 Use the , 

, 

, or 

 buttons to jump to the area you want to check.
3 Select the term that you want to know more about.
4 Close the Window when you are finished.

To move on to the next topic in the browse sequence:

Press 

To go back to the previous topic in the browse sequence:

Press 

 See Also
For Help About New Functions and Terms

For More Information About Using Help in Windows



For Help About New Functions and Terms
Hypertext and hypergraphics give you instant access to more information about on-screen functions and 
terms. They also let you jump quickly to other related topics.

Important!      When you pass the mouse cursor over hypertext or hypergraphics, the cursor changes 
from an arrow to a pointing finger.

 Hypertext
Hypertext displays on your screen as green text, as shown below:

The printer driver includes on-screen examples.

If you click hypertext that has a dotted underline, Help displays a pop-up box that contains more 
information about that term. To close the pop-up box, click a mouse button or press the Esc key on the 
keyboard.

If you click hypertext that has a solid underline, Help jumps directly to that topic.

 Hypergraphics
Hypergraphics are on-screen icons or graphics that you click to perform a function or provide a link to 
more information.

 See Also
How to Find Information in Help

For More Information About Using Help in Windows



For More Information About Using Help in Windows
To learn more about using Helps, see your Windows documentation or select Help from the Program 
Manager's Help Menu for Windows 3.1 or select Help from the Start Menu for Windows 95.



About the EPSON Stylus Series Printing System
Welcome to the EPSON® Stylus™ Series printing system, where printing is fast and effortless and your 
output can be customized for all your printing needs.

You install the EPSON Stylus Series printing system the same way as any other Microsoft® Windows® 
printer driver, but the EPSON driver has some major advantages over conventional Windows technology:

The printer driver includes on-screen examples of how your images will print as you change the printer
driver settings.

The printer driver screen is divided by simple-to-use tab menus that follow the graphic style of 
Windows.

The software release time is much quicker than conventional printer drivers.

Printed colors are richer and truer to the screen image due to the printer drivers automatic color 
adjustment settings.

Photographs look realistic and graphics are smoother because of the drivers advanced halftoning and 
MicroWeave features.

Print time is significantly shorter than with many other ink jet printers, even when the driver is 
processing color images.

The status monitor in the Despooler displays the current printer status and, if you are using Windows 
95, the remaining ink level.

In addition, you can use a wide variety of printer driver options to create fantastic printed images without 
sacrificing overall system performance.

 See Also
Technical Description



The EPSON Stylus Printing System -
A Technical Description
For those users who are familiar with the internal operations of Microsoft® Windows®, the following 
technical description may be of interest.

The EPSON Stylus Series printing system is an advanced Windows GDI-style software printing system 
that operates as follows:

The printer tells the application driver that the printer is a raster device that can render the entire image
in a single band. The driver also reports that certain advanced printing options are supported. All of 
these special capabilities save the application work and avoid the overhead of having to replay the 
image multiple times.

The GDI commands necessary to represent the image are encoded into a highly-optimized journal file.
The application releases when generation of the journal is complete. Compared with the spool files 
generated by standard Windows drivers, journal files are very compact and are the same size 
regardless of whether the print is in color or monochrome. By holding the information in a journal, the 
entire document can be replayed to simulate multiple hardware copies or to provide last-to-first printing
options.

The EPSON Spool Manager is responsible for initiating the EPSON Despooler which replays the 
journal file back to a mini-driver for the target device. Both the EPSON Spool Manager and EPSON 
Despooler use a highly-efficient, multi-threaded tasking system to ensure minimum impact on the 
foreground application.

Additionally, the EPSON Despooler displays the following status items if you are using Windows 95, 
and your computer is equipped with a bidirectional parallel port and a suitable parallel cable:

    Printer status (icon) Time out, During checking, Ink Query Received, During printing, Low ink

    Current ink quantity (bar graph): black, color

 See Also
Despooler and Status Monitor



Copyright and Trademark Information

The EPSON Stylus Series Printing System is a development of Software 2000 Ltd., Oxford, England.

Portions Copyright © 1994,1995,1996 Seiko Epson Corporation

Copyright © 1994,1995,1996 Software 2000 Ltd., Oxford, England

All rights reserved.

All other trademarks of their respective owners are recognized. EPSON disclaims any and all 
rights in those marks.
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 Using the Driver Settings Window
When using the Driver Setting windows, there are two quick ways to learn more about a setting or option 
on the menus:

 The Prompt Box

To see the prompt box, a short explanation of a setting or option, hold the mouse cursor over a setting or 
option for a few seconds.

Note: This kind of help is not available for all the items on your screen. You may have to click the Help 
button and search for help about that item.

 What's This?

If you are using Windows 95, you can get a more complete explanation of a setting or option by right-
clicking that item and then clicking the What's This? box. Help related to that item only will appear. This 
feature is only available in Windows 95.

Note: This kind of help is not available for all the items on your screen. You may have to click the Help 
button and search for help about that item.

 Selecting a Menu
When you access the printer driver, you see the following tabbed menus:

To select a specific menu:

Click the tab at the top of the menu with your mouse or hold down the Alt key and press the underlined 
character in the tab.



 Choosing Settings
After selecting a menu, you can choose settings in any of the following ways:

Click the option button or name

Click the check box

Click the drop-down list box, and then click the item

 Saving Settings

To save your new settings:

Click 

This closes the driver and saves your new settings. Your settings stay in effect until you make additional 
changes and choose the OK button again.

 Restoring Default Settings

To restore the driver's factory default settings:

Click 

 Applying New Settings Before You Exit

To display the effect of your new settings before you exit the driver:

Click 

 Exiting the Driver



There are two ways to exit the printer Driver Settings window:

To exit the Driver Settings window and save your settings:

Click 

To exit the Driver Settings window and ignore your new settings:

Click 

 Displaying Information About the Driver

To display general information about your EPSON Stylus Series printer driver:

Click 

If you need technical support for an EPSON Stylus Series printer, it is a good idea to make a note of the 
version information in this dialog box.

 See Also
A Quick Guide to Using Help



Main Menu
To access the menu that displays the general printer driver options:

Click        You see:

Note: This is the Driver Settings Window for the Stylus COLOR 500. In the driver for the Stylus COLOR 
200 and Stylus 200, Head Unit replaces Ink as the name of the color content option. The function 
remains the same.

Use the Main Menu to select the:

 Document Type  Ink or Head Unit

 Printing Mode  Media Type

 Print Options  Paper Size

 Copies  Paper Source

 Orientation

Note: If you make changes in the Graphics Menu, (Customized) appears on the top of the Main Menu. 
This word remains there until you click Restore Defaults or reset the setting(s) yourself.

 See Also
Graphics Menu



 Graphics Menu
To access the menu that displays the graphics options:

Click       You see:

Use the Graphics Menu for:

 Selecting the Color Matching Method  Adjusting the Image

 Selecting the Halftoning Method  Adjusting the Color Balance

 See Also
Main Menu



 Document Type
The Document Type settings you can make depend on what you want to print and the ink color you 
choose.

            Color Ink     Black Ink

Auto -- Lets your printer driver analyze the print data and automatically adjust the settings to obtain the 
best possible results. For most printing jobs, leave the option set to Auto.

Graph -- Is best for graphics-intensive documents such as presentations.

Photo -- Is best for printing photographs.

Video (Color) -- Is best when printing color images from a digital camera or other video source. If you 
select this setting, the Contrast and Saturation settings (in the Color Balance box) on the Graphics 
Menu automatically change to +20%.

Economy -- Is useful when you want to save ink.

Video (Mono) -- Is best when printing high-quality black-and-white images or drafts of color images taken
by a digital camera or other video source. If you select this setting, the Contrast setting on the Graphics 
Menu automatically changes to +20%.

When you select the document type, the Halftoning and Color Matching options are set automatically 
as shown below:

Options Halftoning Color Matching

Graph Dithering A Match for business graphics
Photo Error Diffusion Match for photo images



Video (Color) Error Diffusion Use driver's matching
Economy Dithering A None
Video (Mono) Error diffusion None

 See Also
Select the Color Matching Method

Selecting the Halftoning Method

Ink or Head Unit



 Ink or Head Unit
The Ink setting determines the color content of your printout for the Stylus Color 500. For the Stylus Color
200 and Stylus 200 series printers, this setting is called the Head Unit. The settings are the same as 
those for the Stylus Color 500.

Note: For Stylus 200 users, the Color setting is available only if the optional Color Upgrade Kit is 
installed.

Mono -- Prints in black only.

Color -- Prints in color using combinations of cyan, magenta, yellow, and black (depending on your 
printer).
Note: If you make a Document Type setting other than Auto, make the Ink or Head Unit setting first and
then set the Document Type.

 See Also
Adjusting the Image

Selecting the Color Matching Method

Document Type



 Printing Modes
When you select the Printing Mode drop-down menu you see:

The three available printing modes are:

Super - 720 dpi

Best - 360 dpi

Economy

If you change the printing mode, be sure that you are using an appropriate Media Type.

Note: The higher the dpi setting, the longer the printing time.

 See Also
Document Type

Ink or Head Unit

Media Type



 Media Type
When you open the Media Type drop-down menu you see:

Your EPSON Stylus Series printer can print on most types of paper. However, to get the best results it is 
important to match the Printing Mode setting to your Media Type setting.

Note:    Before changing the media type, change the printing mode.

The Media Types available for each printing mode depend on your printer model:

Print mode Stylus Color 500 Stylus Color 200, Stylus 200

Super - 720 dpi Plain paper Plain paper (Black only)
Special coated paper - 720 dpi Special coated paper - 720 dpi

        (Color only)
High-quality glossy paper High-quality glossy paper

            (Color only)

Best - 360 dpi Plain paper Plain paper
Special coated paper - 360 dpi Special coated paper - 360 dpi
Transparency Transparency
Special coated paper - 720 dpi
      (color only)

Economy Plain paper Plain paper

The available Media Type settings are:

Plain paper

Select this option for most types of documents. You should also select this option if you are not using 
special coated paper, high-quality glossy paper, or transparencies.

Special coated paper - 360 dpi

For good print quality, use EPSON Special coated paper for 360 dpi printing and select this option.

Special coated paper - 720 dpi

For excellent print quality, use EPSON Special coated paper for 720 dpi printing or EPSON High-quality 
glossy paper and select this option. This setting should also be used when printing on the front (coated) 
side of EPSON Special coated index card for 720 dpi printing. If you want to print on the back of an index 
card, select Plain paper as the Media Type.

Transparency

To print overhead transparencies, use EPSON Transparencies and select this option and the Best - 360 



dpi printing mode.

Note:    Use EPSON Transparencies only. No other type of transparency is supported.

High quality glossy paper

To print on high quality glossy paper, use only EPSON high quality glossy paper and select the Super - 
720 dpi printing mode.

Note:    Use EPSON high quality glossy paper. No other type of glossy paper is supported.

 See Also
Printing Modes

Ink or Head Unit



 Print Options
Under Print Options on the Main Menu you see:

Your Print Options settings are:

MicroWeave

When MicroWeave is selected, your printer generates superior output because your graphics data is re-
ordered and printed in finer increments. This technology reduces the possibility of banding -- unwanted 
lines in graphics.

For best results, use EPSON's special coated paper, transparencies, or high-quality glossy paper with 
MicroWeave.

Note:    MicroWeave is recommended for printing in color. You can select MicroWeave for Monochrome 
printing, but the printing time is significantly longer.

High Speed

When you select this option, printing is performed in both directions: from left to right and right to left. 
Bidirectional printing is faster and is recommended for most printing jobs except for detailed graphics.

 For Stylus Color 200 and Stylus 200 Users
The High Speed default setting is off when printing in monochrome but on when printing in color.

 For Stylus Color 500 Users
The High Speed default setting is on when printing in monochrome or color.

 See Also
Printing Modes

Media Type

Document Type



 Paper Size
In the Paper Size drop-down menu you see:

Select the paper size you have loaded in the printer. Your choices are:

Type Dimensions

Letter 8-1/2 X 11 inches
Letter (Centered) 8-1/2 X 11 inches
Legal 8-1/2 X 14 inches
Legal (Centered ) 8-1/2 X 14 inches
A4 210 X 297 mm
A4 (Centered) 210 X 297 mm
Statement 5-1/2 X 8-1/2 inches
Executive 7-1/4 X 10-1/2 inches
Envelope #10 9-1/2 X 4-1/8 inches
Envelope DL 220 X 110 mm
A6 Index card 105 X 148 mm
B5 176 X 250 mm
User defined 100 to 329 mm X 100 to 1117 mm

Note:    Always load paper into the sheet feeder short edge first except for envelopes. Load envelopes 
long edge first.



 Copies
These settings let you specify the number of copies and the printing order.

 Entering the Number of Copies

To specify the number of copies:

1 Click in the number box and type the number you want, or...

2 Click the arrows next to the number box.

You can enter a number from 1 to 99.

 Choosing the Collation Method
The two additional options in the Copies box are Collate and Reverse Page Order. Click on these 
options to turn them on. A check inside the box indicates the option is turned on. The option is turned off 
when the box is empty.

To print multiple-page documents in sets:

Turn Collate on by clicking the check box.

To print one or more document sets so that each is stacked in the correct order after printing:

Click both the Collate and Reverse Page Order check boxes.

To print one multiple-page document so that its pages are in the right order after printing:

Click only Reverse Page Order.

Note:    The above options may require additional system memory. If a memory error message appears 
and you are unable to print your document, you should increase system memory, decrease the number of
open applications, reduce the size of your document, or turn off collation and/or reverse page ordering.





 Paper Source

The Stylus COLOR 500, Stylus COLOR 200, and Stylus 200 printers have a built-in sheet feeders, so you
do not need to change this setting.



 Page Orientation
To change the orientation:

Click the appropriate option button to specifity the orientation of the image on the page.

Portrait -- Prints on the page upright.

Landscape -- Prints on the page lengthwise, which is useful for spreadsheets or presentations.

Note:    Normally, you should select the page orientation in your software application, not with the driver.



 Selecting the Color Matching Method

This feature provides you with several color matching schemes that give you more control over the color 
in your printouts. Color Matching can also be turned off.

When Auto is selected in Document Type, the printer driver analyzes the data for each page of your 
document and automatically adjusts the Color Matching settings.

Note:    You may need to experiment with different settings until you get the output you want. Also, Color 
Matching is not available when Mono is selected in the Ink (Head Unit) option.

The following settings are available:

Disables color matching.

Enables Windows 95 color matching. This option is not available with Windows 3.1x. Also, this option is 
only available in a few cases, such as when you print at 720 dpi using Error Diffusion. Use the driver's 
color matching system whenever possible.

Enables matching by the EPSON Stylus Series driver.

Intensifies the colors and lightens the midtones and highlights of an image. Use this setting for 
presentation graphics, such as charts and graphs.

Increases the contrast in an image. Use this setting for color photographs.

Provides output that closely matches the original screen colors. Use this setting for computer generated 
illustrations or art.

 See Also
Adjusting the Image Settings

Document Type



 Adjusting the Image Settings

The Image settings include Brightness and Contrast.

Brightness
The Brightness option changes the lightness or darkness of an image. You can adjust the brightness in a
range of -50% to +50%.

To adjust the brightness:

Click the arrows or drag the scroll bar to the right or left with your mouse.

Contrast
The Contrast option changes the ratio between the lightest and the darkest parts of an image. You can 
adjust the contrast in a range of -50% to +50%.

To adjust the contrast:

Click the arrows or drag the scroll bar to the right or left with your mouse.

Note:    You can confirm the effect of the setting by looking at the image on the right side of the Image 
window.

 See Also
Selecting the Color Matching Method



  Selecting the Halftoning Method
To print an image that looks like the image on your screen or the scanned original, the printer driver 
processes the image by using halftoning. Halftoning is a method of converting a continuous tone image 
into patterns of tiny dots that represent the image. This process is similar to the one used to print 
photographs in magazines and newspapers.

The halftoning method you choose depends on the type of image you are printing. The image next to 
Halftoning changes to show the effect of the selected setting.

To take advantage of EPSON's intelligent color correction feature, select the Auto option from Document 
Type. When Auto is selected, the printer driver analyzes the data for each page of your document and 
automatically adjusts the settings.

Note:    The quality of printed graphics is directly affected by the halftoning method you choose. You may 
need to experiment with different settings to get the output you want.

The options are:

Use this setting for text only documents. This is the fastest setting.

Use this setting for photographic images or equivalent drawings. This produces the highest quality output.

Use this setting for graphic images with significant detail but limited shading.

Use this setting for graphic images with limited detail and shading.

 See Also
Document Type

Media Type

Selecting the Color Matching Method



    Adjusting the Color Balance

The Color Balance settings include Saturation, Red Strength, Green Strength, and Blue Strength.

Saturation
The Saturation option changes the vividness of color. Negative saturation produces colors that are softer 
than those produced with positive saturation. You can adjust the saturation in a range of -50% to +50%.

To adjust the saturation:

Click the arrows or drag the scroll bar to the right or left with your mouse.

Red, Green, and Blue Strength
These options adjust the amount of each of the three primary colors. You can adjust the strength in a 
range of -50% to +50%.

To adjust one or all of the color strengths:

Click the arrows or drag the scroll bar to the right or left with your mouse.

You can confirm the effect of the setting by looking at the image on the right side of the Color Balance 
window.

Note:    These settings cannot be changed when Mono (black ink only) is selected in the Ink (Head Unit) 
option

 See Also
Selecting the Color Matching Method
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 General Printing Procedures
This section describes the day-to-day procedures you can use to get the best performance and output 
from your Stylus Series printer.

 Using the Auto Mode
For most printing jobs, leave Document Type set to Auto in the Main Menu. This setting lets your printer 
driver analyze the print data from your application and automatically adjust the settings to obtain the best 
quality printout.

If you want to select a setting other than Auto, select the Ink setting first and then change the Document 
Type.

 Using the Main Menu
You would normally use the Main Menu to select options that your applications cannot provide.    These 
include:

 Document Type

 Ink or Head Unit

 Printing Mode

 Print Options

 Media Type.

 Using Your Application Software Settings
The following settings can be made through the driver's Main Menu, but these are settings that you would
normally choose from your application software:

 Paper Size

 Copies

 Paper Source

 Paper Orientation.

 See Also
Special Printing Procedures



 Special Printing Procedures
Color printing is an art that is both highly technical and very subjective. This is why EPSON has provided 
the Graphics Menu, which gives you a level of control unmatched by many application programs.

 Matching Screen Output to Print Output
If you find that the colors you see on the screen do not match your printout, you may need to change the 
Color Matching option.

 Adjusting Your Color Output
When you are working with photographs, video images, or scanned images, you may find that your 
application cannot provide the expected brightness, contrast, or color intensity. If this is the case, you may
want to experiment with the following settings in the Graphics Menu:

 Image Adjustment

 Halftoning

 Color Balance

 See Also
General Printing Procedures
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 About the Spool Manager and Despooler
When you print a document, the Epson Stylus Series printer driver converts the print job into a journal file.
To quickly release your software application from the task of printing, this journal file is sent to the default 
spool directory by the EPSON Spool Manager. The Spool Manager then assigns the journal file to the 
appropriate print queue. When the journal file reaches the front of the queue, it is sent to the EPSON 
Despooler and then to the target printer.

The Despooler appears on your screen when it receives a journal file to show you the progress of the 
current journal file and to identify printer status information such as paper out and printer off line. If you 
are using Windows 95, the Despooler also includes the Status Monitor, which provides more information 
about printer status and remaining ink status.

The Spool Manager gives you complete control over the Despooler, print queues, and journal files and 
also allows you to enable remote network printing.

The Spool Manager starts automatically when you select Print from your application. The Spool Manager 
remains an active icon on your Windows desktop until you close it or exit Windows. The icon is shown 
below:

You can also start the Spool Manager directly from the EPSON Windows group by double-clicking the 
icon.

Note: The Despooler appears when a journal file is being sent to the printer. If you do not want the 
Despooler to appear, you can turn off the Show Despool Popup option in the View Menu of the Spool 
Manager.

 See Also
Spool Manager

Despooler and Status Monitor



    Spool Manager
To access the Spool Manager:

Double-click  from the Windows desktop or the EPSON group icon. You see:

From the Spool Manager you can select:

 The Spool Manager Window  The Queue Menu

 The Document Menu  The View Menu

 The Options Menu  The Help Menu



The Spool Manager Window
The Spool Manager window shows the list of EPSON Stylus printer queues. Journal files that are 
currently printing or waiting to be printed will be shown in the assigned queue.

 Queues
Queues shown in normal text represent printers that are supported by the EPSON Stylus Series printing 
system. Queues shown in faint text are supported by other (conventional) Windows printer drivers.

You can change the options of an EPSON Stylus print queue by double-clicking on it or by clicking once 
to select it and then choosing an option from the Queue menu.

 Journal Files
Journal files are shown in their assigned queue. If you double-click a journal file, a dialog box appears. In 
this dialog box you can check journal file information, such as file size and status. You can also stop 
printing a file, place it on hold, delete it, or re-queue it for later printing.

Alternatively, you can click a file and then choose an option from the Document menu



The Queue Menu
The Queue menu allows you to place EPSON Stylus print queues on hold, release them to allow journal 
files to be printed, and identify queues as local or remote (network printing). These options are described 
below:

 Holding or Releasing a Queue

To hold or release a queue:

1 Select the queue.

2 Click the Hold option on the Queue menu.

A check mark beside the Hold option indicates the queue is currently on hold. When a queue is on hold, 
the Spool Manager places a wait symbol on the printer icon associated with the queue, and journal files 
are not submitted for printing.

 Using the Windows Print Manager
The EPSON Despooler normally prints directly to the printer.

To schedule print jobs through the conventional Windows Print Manager:

1 Select the queue.

2 Either double-click the queue or select the Setup option on the Queue menu.

3 Select Use Print Manager for this port option and choose the OK button.

 Network Printing
The EPSON Stylus Series printing system allows you to send journal files from your workstation (Host) to 
a shared directory on a network server. These files can then be printed by another workstation (Remote) 
set up to run the EPSON Spool Manager and associated EPSON Stylus printer driver(s). You can do this 
as follows:

To set up the Host:



1 Select the queue.

2 Either double-click the queue or select the Setup option on the Queue menu.

3 Click the Spool to remote printer button.

4 Click the Browse button and select the spool directory on the remote server which should receive
journal files from the spool manager.

To set up a Remote workstation:

1 Install the EPSON Stylus Series printing system and the required printer driver(s).

2 Access the EPSON Spool Manager from the EPSON Program Group.

3 Either double-click the queue or select the Setup option on the Queue menu.

4 Select the Remote Despool tab and click the Printing from remote queues option.

5 Click the Browse button and select the spool directory on the remote server that will hold journal 
files from host workstations.

6 Journals files will be identified by the EPSON Spool Manager and submitted for printing.



The Document Menu
The Document menu allows you to control journal files in your EPSON Stylus print queue. Journals can 
be held, re-queued for printing later, deleted, or kept for subsequent re-printing.

To select options for a journal file, click the journal file and select an option on the Document menu.



The View Menu
The View menu allows you to limit the amount of information displayed by the EPSON Spool Manager. In 
addition, you can control the EPSON Despooler pop-up display. When options in the View menu are 
selected, the EPSON Spool Manager places a check mark beside them.

If the Show Despool Popup option is not selected, the EPSON Despooler window will not appear when 
journal files are submitted for printing. It will appear, however, if an error is reported by the printer.



The Options Menu
The Options menu controls the default spool directory, timer, and font selections.

 Default Spool Directory
Choose this option to override the default TEMP directory setting. Journal files will be sent to this directory
instead. This option is equivalent to the Spool Directory setting in the Queue Menu Setup option except 
that it applies to all queues.

 Timers

Update Timer

The Update Timer tells the EPSON Spool Manager how often to refresh the information displayed in the 
EPSON Spool Manager window.

Remote Timer

The Remote Timer tells a remote EPSON Spool Manager how often to look for new journal files in a 
network directory.

See the Queue Menu for more details about network printing.

 Font
This option allows you to set the default font that the EPSON Spool Manager uses for displaying 
information in the Spool Manager window. All of your installed Windows fonts are available.



The Help Menu

The Help option displays a help system only for the Spool Manager.

The Help menu provides copyright, trademark, and version information about the EPSON Spool Manager
through the About option.

 See Also
About the Epson Stylus Series Printing System



 Despooler and Status Monitor
The Despooler automatically appears when the Spool Manager sends a journal file to be printed. You see:

Note: The Status Monitor appears only if you are using Windows 95 with a local printer.

From the Despooler you can:

 Access Journal File Control  View Printer Status

 View Printer Status Under Windows 95 (Status Monitor)



 Journal File Control
The EPSON Despooler lets you set the level of control over printing in the same way as with the options 
on the Document menu of the EPSON Spool Manager.

 Buttons
The following buttons gives you full control over journal file printing:

 Stop -- Cancels printing.

 Pause -- Pauses printing until you press it again.

 Reprint -- Restarts printing from the current page or reprints the document.

 About and Help
The About button provides version and trademark information about the EPSON Despooler. The Help 
button brings you directly to this Help window.

 See Also
Spool Manager



Viewing Printer Status

The progress of the current page is shown by the image of a document in the upper right of the despooler
window. Each page of the document is divided into one or more horizontal bands for processing. Once a 
band is sent to the printer, the Despooler starts to process the next band. If your document is very simple,
there may be only one band per page. If your document is complex (such as a graphic image) or your 
computer has little free memory, there will be many bands.

Status messages and symbols representing error conditions are displayed on the image of your printer in 
the despooler window.

When you correct a problem with the printer, the Despooler continues with the print job.    If a serious error
occurs, such as printer power failure, you may need to re-queue the journal and print again.



 Viewing Printer Status Under Windows 95
If you are using Windows 95 and your computer system is equipped with a bidirectional parallel port and a
suitable interface cable, the lower portion of the Despooler window displays the following Status Monitor:

The Black Ink and Color Ink level indicators provide a graphical representation of the amount of ink in 
the printer. As you use up ink, the indicator drops in 25% (quarter) increments. When the level drops to 
20%, the indicator turns yellow. When the level drops to 10% or less, the indicator is red.

The printer icon in the Status Monitor changes according to the printer's status. The printer icons convey 
the following messages:

Checking the printer status.

An error has occurred. Your printer cannot print. Check your printer and then resend the print job.

The printer is ready.

The printer is printing.

The ink level is low or out.

Note: This feature is not available for printers connected through a network.



    Printer Status
Even if you have turned off Show Despool Popup on the View Menu of the Spool Manager, the EPSON 
Despooler pops up only when errors, such as paper out and printer off line, are reported by your EPSON 
Stylus printer. Try taking the printer off line or removing paper from the input tray while printing to 
demonstrate this capability.
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About
There are several menus and windows in the Stylus printing system that give you information about the 
EPSON printer driver. These areas display an "About" button or option. Click this button or option to get 
more information.



Additive colors
Colors that are produced by adding together the varying intensities of the three primary colors: red, green,
and blue.



Best - 360 dpi
A Stylus Series printing mode that prints quickly at 360 dpi (dots per inch) resolution. This mode is best 
for plain paper, special coated paper - 360 dpi, and transparency film.

You can use this mode for both monochrome and color printing. 



Bidirectional Parallel Port
A bidirectional parallel port allows data to flow between your computer and printer. This means that your 
EPSON Stylus printer can send special information back to your computer. See your computer user's 
guide (or ask your dealer) to see if your computer is equipped with a bidirectional port.

Most computer systems come with a bidirectional (PS/2 type) parallel port that meets the IEEE 1284 
Standards. If your system is not equipped with this type of port, you can usually purchase a bidirectional 
parallel interface card from your local computer dealer.



Bidirectional printing
Images are printed in both directions for faster printing. The High Speed setting on the Main Menu 
enables this type of printing.



Brightness
The lightness or darkness of an image. You can adjust the brightness of a printed image from the Image 
option on the Graphics Menu.



Browse Sequence
A browse sequence follows a path through the topics in Help in a certain order. Press the > key on your 
keyboard to proceed to the next screen in the sequence.

The browse sequence in the Epson Stylus Help Window helps you learn how to use the most important 
features of your printer driver.



Cancel button
Click the Cancel button to exit the printer driver without saving any changes to driver settings.



 CMYK
Cyan - Magenta - Yellow - BlacK.

The three primary process (subtractive) colors plus black.



Collate copies
You can choose to print your document in order from the first page to the last or reverse the order and 
print from last to first. You can also elect to collate (sort) a multi-page document into sets. These options 
are available on the Main Menu.



Color Balancing
The process of adjusting color printout for saturation (hue) and red, green, and blue strength. You can 
adjust the color balance on the Graphics Menu by clicking the Color Balance button and then using the 
arrows or scroll bars to increase or decrease color stringth.



Color matching
The process that your driver uses to match colors that appear on your screen to the colors in your 
printout. You select a color matching option from the Graphics Menu. If you don't see the color matching 
section on the Graphics Menu, click the Color Matching button to make it appear.



Contrast
The degree of difference between the darkest and lightest areas in an image. The greater the difference, 
the higher the contrast value. You can adjust the printed image contrast from the Graphics Menu.



Copies
The number of times you want to print a document. The default value is 1.

You can enter a different value on the Main Menu, but you should normally select multiple copies from the
Print function of your application.



Default Settings
Stored settings that take effect when the equipment is turned on, reset, or initialized. You can restore your
driver's default settings at any time by pressing the Restore Defaults button on the Main and Graphics 
Menus.



Default Spool Directory
As part of the first step in the printing process, print data is sent to the default spool directory. This 
directory is normally specified by the DOS environment string SET TEMP= in your CONFIG.SYS file.

You can change the default directory by selecting Default Spool Directory from the Options Menu in the
EPSON Spool Manager.



Restore Defaults Button
Click the Restore Defaults button on the Main or Graphics Menu to reset the factory settings for that 
menu.



Despooler
The Despooler takes the journal files from the Spool Manager and sends them to the printer. The 
Despooler appears on your screen when it receives a journal file, and you can use the Despooler to stop, 
pause, or reprint a journal file. If you are using Windows 95, the Status Monitor appears at the bottom of 
the Despooler.



Dithering
A halftoning method that arranges dots on a page to simulate a shade or tone. You can select either 
Dithering A or B as the halftone setting. You may have to experiment with the halftone setting to find the 
method that best suits your printing needs. The Error Diffusion setting usually gives the best results.



Dithering A
A halftoning option on the Graphics Menu for graphic images with limited detail and shading.



Dithering B
A halftoning option on the Graphics Menu for graphic images with significant detail but limited shading.



Document Type
An option in the Main Menu that allows you to choose settings according to the type of document you are 
printing. In general, you should leave this option set to Auto.



Document Type Options
There are five Document Type options on the Main Menu -- Auto, Graph, Photo, Video, and Economy. 
In general, you should leave the setting set to Auto.

Note: The available Document Type options depend on the Ink (Head Unit) setting. When Color is 
selected, the available document types are Auto, Graph, Photo, and Video. When Mono is selected, 
you can select from Auto, Economy, and Video.



Document Menu (Spooler)
A drop-down menu in the Spool Manager that allows you to hold print jobs, re-order them for later printing,
delete them from the queue, or save them for reprinting.



dpi
dots per inch. This is the number of dots your printer can print in a one linear inch. Note that if you double 
the dpi, you increase the total number of dots by a factor of four.

Note:    The Printing Modes options do not always yield the same resolutions in both the vertical and the 
horizontal directions.



Economy
A Stylus Series printing mode that saves ink. This mode is best for printing rough drafts on plain paper.

You can use this mode for both monochrome and color text printing.



EPSON Stylus Printing System
A term used to describe the Stylus Series printer, printer driver, Spool Manager, and Despooler, which 
includes the Status Monitor for Windows 95.



EPSON Stylus Series Printer Driver
The printer driver is usually accessed through your applications Printer Setup option or through the 
Printers icon of the Microsoft Windows Control Panel.

The printer driver allows your computer to use all of the features and capabilities of your EPSON Stylus 
Series printer.



Error Diffusion
A halftoning option on the Graphics Menu for photographic images or equivalent drawings. This is the 
highest quality but slowest halftoning option.



Font Menu (Spooler)
You can use this menu to change the Spool Manager window font. You access this menu from the drop-
down Options Menu in the Spool Manager.



Graphics Menu
A menu in the Stylus printer driver that allows you to set the image brightness and contrast, color 
balancing, halftoning method, color matching method.



Halftoning
Methods of using tiny dot patterns to represent images. Halftoning provides better graphic printout, but 
slows down printing.



Halftoning Options
Options in the Graphics Menu that allow you to choose from four halftoning methods -- No halftoning, 
Error Diffusion, Dithering A, and Dithering B.



Help Button
Press the Help button to display the Stylus printing system Help Window.



High Quality Glossy Paper
Special coated paper for ink jet printers that give you the best picture quality.



High Speed
An option in the Main Menu that turns on bidirectional printing for faster print speed. This mode is good for
drafts and low-detail drawings and graphs.



Holding (Queue)
If a journal file is still in the Spool Manager Queue Menu, you can delete it or place it on hold for printing 
later.



Ink Cartridge
The plastic, replaceable ink container. The Stylus Series printers use one color (CMY) cartridge and one 
black cartridge.



Ink Jet
A method of printing in which each letter, symbol or image is formed by precisely spraying ink onto paper.



Ink Options
The two ink options are Color (full color printing) or Mono (monochrome printing). You can choose this 
option on the Main Menu in the Driver Settings window.



Journal File
The EPSON Stylus Series printing system generates a compact journal file that contains a complete 
description of your print job in a form that can be processed easily. This journal file is similar to a tape 
recording in that it can be played, replayed, or played back-to-front (Reverse Page Order) in order to 
process your print job.



Landscape
The Orientation setting on the Main Menu that causes your printer to print lengthwise. The opposite is 
Portrait.



Main Menu
The primary menu in the Stylus printer driver that allows you to make the most common driver settings.



Media
The type of materials on which data is printed such as envelopes, plain paper, special coated paper, and 
transparency film.



Media Type Options
Main Menu options that allow you to choose the media type -- Plain paper, Special coated paper - 360 
dpi, Special coated paper - 720 dpi, High-quality glossy paper, and Transparency film.



MicroWeave
When MicroWeave is selected, the EPSON Stylus Series printer driver enhances the quality of printed 
images. This is done by passing the print head over the page multiple times, laying down parts of the 
image on each pass. This unique technique reduces unwanted banding in images.

Images printed by other ink jet printers often have distracting horizontal bands that appear darker or 
lighter than the rest of the image. With the MicroWeave option turned on, these bands in images are 
minimized and your EPSON Stylus output looks truly professional. MicroWeave does not affect text 
output quality.

Since MicroWeave requires several passes during printing, printing time increases. To save time, you 
should use it only for presentation quality images.

MicroWeave does not affect color printing speed significantly so you should use it for all color printing.



Network Printing
Your Stylus Series printer is designed to be used as a network printer. You can turn the network interface 
mode on or off from the printer's control panel.

You can also control network print queues from the Spool Manager Queue Menu.



No Halftoning Option
A halftoning option on the Grapics Menu that allows you to turn halftoning off. This option is used for 
printing drafts, simple graphics, or text.



OK Button
Press the OK button at the bottom of the Driver Settings window to save all setting changes and exit the 
driver.



Options Menu (Spooler)
A menu in the Spool Manager that allows you to change the Default Spool Directory, adjust timers, and 
change the default font for the Spool Manager window.



Orientation
There are two ways you can print on your media: Portrait and Landscape. In portrait orientation, the top 
of the page is parallel with the short edge of the paper. Landscape images are printed with the top of the 
page parallel to the long edge of the paper. The Landscape option is ideal for printing wide spreadsheets.



Paper Size Options
An option that lets you select the size of paper for printing. You must change this option in the Main Menu 
to the paper size in your printer. The default paper size is Letter (8.5 X 11.0 inches).



Paper Source Option
The default paper source for the Stylus Series printers is Auto Sheet Feeder. This setting cannot be 
changed.



Portrait
Portrait images look like this screen. Images are printed with line of text parallel to the short edge of the 
paper. The opposite is Landscape.



Head Unit
The name of the option in the printer driver for the Stylus Color 200 and Stylus 200 that controls the color 
content in your printout. This option is called Ink in the Stylus Color 500 printer driver. All other names and
functions are the same.



Queues
A queue is a list of journal files that are currently printing or waiting to be printed. Queues are always 
associated with a local or remote (across a network) print device.

An icon representing your print device is displayed with the printer and queue names. The EPSON Spool 
Manager places a wait symbol on the icon when the queue is on hold or paused. You can hold a queue 
using the Hold command on the Queue Menu.



Queue Menu (Spooler)
A menu in the Spool Manager that allows you to place journals on hold, release them to be printed, and 
identify if a queue is local or remote.



Release Time
This is the time it takes to regain control of your application after you send a print job to the printer.

The EPSON Stylus Series printing system quickly processes the print job and then releases your 
application so that you can continue working while your printing completes in the background.



Releasing a Queue
You can use the Spool Manager Queue Menu to release journals you have placed on hold. The journals 
will then be printed.



Reverse Page Order
This is an option under copies on the Main Menu that lets you print your document from the last page to 
the first. This option is useful for multi-page documents that you want to print in normal reading order.



Special Coated Paper - 360 dpi and 720 dpi
Special coated used for high quality printing at 360 dpi or 720 dpi. Use this paper in Best - 360 dpi or 
Super - 720 dpi dpi mode when you print highly detailed images.



Spool Manager
When you print your document, the printer driver uses a print spool manager to send the data to the 
Despooler and then to the printer. This releases your computer and allows printing to take place in the 
background.

The Spool Manager icon appears when you send a print job. Double-click the icon to open the Spool 
Manager window.



Status Monitor
A dialog box that appears at the bottom of the Despooler when you send a print job. It provides 
information on current printer status and ink cartridge supply levels.

You must have Windows 95, a bidirectional parallel port, and a suitable interface cable to be able to use 
the Status Monitor.



Super - 720 dpi
A Stylus Series printing mode that produces photograpic quality output at a slower speed and 720 dpi 
resolution. This mode is best when used with special media such as high-quality glossy paper and on 
special coated paper.

You can use this mode for both monochrome and color printing.

Note:    Do not use this mode when printing on transparency film.



Timers Option (Spooler)
There are two types of timers associated with the Spool Manager -- the Update Timer and the Remote 
Timer.

The Update Timer tells the EPSON Spool Manager how often to refresh the information displayed in the 
Queue Menu.

The Remote Timer tells a remote EPSON Spool Manager how often to look for new journal files in a 
network directory.



Transparency Film
Specially prepared transparency film for use on overhead projectors. You must use only EPSON 
transparency film that is designed for use with ink jet printers.

Use the Best - 360 dpi mode when you print on transparency film.



Windows GDI
Graphics Device Interface (GDI). This is the part of the Microsoft Windows environment that allows 
programmers to draw lines, circles, polygons, and text and control other graphics elements on the output 
device (screen, printer, plotter, and so on).



WYSIWYG
What You See Is What You Get. Generally with the EPSON Stylus Series printing system, what you see 
on the screen is what you get in your printout in terms of colors, image size, and print density.



View Menu (Spooler)
The Spool Manager has a drop-down View Menu that allows you to limit the amount of information that 
the Spool Manager displays. You can also choose to keep the Despooler from appearing when you print.




